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Introduction

Microsoft Outlook has become an essential business tool in the years since 
it was first released in the 1990s. If you work in a company that employs 
more than a dozen people, it’s a pretty good bet that you’ll be using 

Microsoft Outlook to manage your email and calendar. Whether you’re giving or 
taking directions, organizing meetings, collaborating on important projects, or just 
keeping up with business, Outlook is what you’ll use to get it done quickly. Outlook 
has become even more important to businesses in recent years, with more compa-
nies encouraging telecommuting and hiring employees who work from home.

Outlook is not just for business use, though — far from it. Outlook is also the 
application of choice for millions of people who use it for their own personal com-
munication needs. Students use it to communicate with their teachers and fellow 
students about academic projects. Parents use it to manage the family calendar so 
that everyone knows where they need to be. Hobbyists use it to communicate with 
other people who share their passion for whatever makes them smile, whether it’s 
birdwatching, woodworking, or role-playing games.

Outlook: What Is It Good For?
Outlook is a personal information manager that can act as your assistant in deal-
ing with the flurry of small but important details that stand between you and the 
work (or play) you do. It sends and receives email, maintains your address book, 
schedules meetings and appointments, tracks your to-do list, and more, all in one 
place. Here are just a few of the cool things it can do for you:

 » Send email messages to individuals or groups, including attachments, 
graphics, text formatting, signature blocks, and more.

 » Keep an address book of all your contacts with consistently up-to-date 
information.

 » Manage multiple calendars (such as for work and for home) and overlay their 
appointments in a single view so you can make sure there aren’t any conflicts.

 » Schedule a meeting and reserve a conference room in your workplace and 
then send out meeting invitations and track who has accepted or declined.
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 » Organize hundreds of little pieces of data with digital “sticky notes” that you 
can search, sort, and color code.

About This Book
Outlook For Dummies is your one-stop guide to all things Outlook. Whether you’re 
brand-new to Outlook or a long-time casual user looking to go deeper, you’ll find 
the help you need here. The book is organized in five parts, each with a spe-
cific theme:

Part 1: Getting Started with Outlook. Start here if you’re not already familiar with 
Outlook at a basic level. Here you’ll get an overview of what Outlook does, take a 
guided tour of the interface, and learn some handy shortcuts for getting around.

Part 2: Taming the Email Beast. If you’re mostly interested in Outlook’s email 
capabilities, start here. You’ll learn how to send and receive messages with all 
kinds of different options, like attachments, special formatting, signature lines, 
and read receipts. You’ll also learn how to organize your messages into folders, 
create mail-handling rules that automatically move incoming messages into cer-
tain folders, and set up multiple email accounts to work with Outlook. You’ll even 
find out how to do a mail merge using email addresses!

Part 3: Keeping Track of Contacts, Dates, Tasks, and More. In this part you learn 
about several of Outlook’s tools for organizing your busy life and schedule. You 
see how to set up your address book, how to schedule meetings and appointments 
on your calendar(s), and how to manage your to-do list. We also take a look at 
some extra features that you only get if your email account is hosted on an 
Exchange server, and you’ll discover how to integrate calendars from Google and 
iCloud into the Outlook Calendar.

Part 4: Exploring Other Versions of Outlook. Did you know that several different 
versions of Outlook are available, and that each one works differently? It’s true! 
Most of this book is based on Outlook 365, but in this part, you learn about Outlook 
for Windows (a.k.a. New Outlook), the Web version of Outlook, and Mobile Outlook 
for devices that run iOS or Android.

Part 5: The Part of Tens. As is customary in a Dummies book, I wrap things up by 
providing some Top 10 lists that you can skim at your leisure. You learn about 
ten  time-saving shortcuts, ten ways to customize Outlook, and ten things that 
Outlook  actually can’t do (so you can stop banging your head against the wall 
trying to get them to work!).
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Outlook 365 for the Win!
As I explain in more detail in Chapter  1, several different applications all call 
themselves Outlook, including paid versions for business computers running 
Windows or macOS and free versions for mobile devices, for casual users of 
Windows (as of 2024), and for those who want a web-only Outlook interface. 
It gets confusing!

This book is based on the full-featured subscription-based version called Outlook 
365. It’s the one that most businesses rely on and by far the most powerful and 
feature-rich version. I provide an overview of the other versions in Part 4, but if 
you don’t have Outlook 365, this book is probably not for you.

Outlook 365 is part of a larger suite of applications called Microsoft 365. It used to 
be called Office 365, but it underwent a rebranding a few years back. With your 
subscription to Microsoft 365, you always have the most recent version of every 
app at no extra charge, even if a major new version comes out. Microsoft silently 
rolls out new features and tweaks nearly every month via automatic download and 
installation. One day you’ll open up Outlook and notice a new feature, or you’ll see 
that the interface looks slightly different (and hopefully you’ll think it’s an 
improvement!). Different Microsoft 365 subscription plans are available for  
individuals, businesses, and schools and contain different combinations of the 
various applications. (They all include Outlook 365, though.)

Because Outlook receives periodic updates and improvements, you might see 
some minor differences in your Outlook interface compared to what’s shown and 
described in this book. This is unavoidable — at least until I get my hands on a 
time machine.

Foolish Assumptions
As I wrote this book, I made certain assumptions about you, its reader. For 
one thing, I assume you know how to turn on your computer, use a mouse and 
keyboard, and navigate your way around Microsoft Windows. If Windows is 
strange to you, I recommend picking up Andy Rathbone’s Windows 11 For Dummies.

And, as I mention in the preceding section, I assume you have a Microsoft 365 
subscription, which includes Outlook 365. Current versions of Windows come with 
a free mail program that is confusingly called Outlook (New), but that is not the 
version you need to get the most out of this book.
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I’m not making any assumptions about whether you’re a home or business user; 
this book has plenty of help for both.

Icons Used in This Book
Keep an eye out for the following icons sprinkled throughout the chapters — these 
little pictures draw your attention to specific types of useful information:

The Warning icon points to something that can prevent or cause problems — good 
stuff to know!

The Remember icon offers helpful information. (Everything in this book is help-
ful, but this stuff is even more helpful.)

The Tip icon points out a hint or trick for saving time and effort or something that 
makes Outlook easier to understand.

The Technical Stuff icon identifies background information that casual users can 
skip, although it may make for good conversation at a really dull party.

Beyond the Book
In addition to the material in the print or ebook you’re reading right now, this 
product comes with some goodies on the web that you can access anywhere. 
No matter how well you understand the concepts of Outlook, you’ll likely have a 
few questions and won’t have a clue about how to get the answers you need. 
Simply go to www.dummies.com and search for “Outlook For Dummies Cheat 
Sheet” in the Search box.

https://www.dummies.com
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IN THIS PART . . .

Learn how to use Outlook to read and send email, send 
attachments, and create appointments and tasks as well 
as how to use the Calendar feature to help you meet 
important deadlines.

Explore the various parts of Outlook, including views, 
menus, and folders. Find what you’re looking for with 
the Search feature.

Discover how to create contacts and calendar 
appointments and how to use dragging, how to create 
and modify tasks, and how to further enhance your 
productivity.
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Chapter 1
A First Look at 
Outlook 365

This book kicks off with Outlook’s greatest hits — the things you’ll want to 
do with Outlook every single day. The list sounds simple enough: sending 
email, making appointments, and so on. But there’s more here than meets 

the eye; Outlook does ordinary things extraordinarily well.

Most people use only about 5 percent of Outlook’s power. (Hey, that’s kind of like 
how people only use a small percentage of their brains!) Even if you move up to 
using 10 percent of Outlook’s features, you’ll be amazed at how this application 
can streamline your life and spiff up your communications.

IN THIS CHAPTER

 » Checking your Outlook version

 » Switching to the Simplified Ribbon

 » Reading and creating email

 » Sending files by email

 » Checking your calendar

 » Entering appointments and contacts

 » Managing tasks

 » Keeping notes
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Making Sure You Have Outlook 365
Before we go any further, it’s important to make sure you have the version of 
Outlook that this book covers: Outlook 365. Otherwise, you’re in for a world of 
confusion as you try to follow along!

At least five different applications are all called Outlook: 

 » Outlook 365 (a.k.a. Outlook Classic, or Classic Outlook): The version that 
comes with the paid edition of Microsoft 365 (also called Microsoft Office). It’s 
the one most businesses use, and the one I teach you about in this book. If 
that’s the one you have, you’ve come to the right place! It’s available for both 
Windows and Mac. The Outlook 365 for Mac version is quite similar to the 
Windows one but has fewer features. Here’s an article that explains the 
differences: https://tinyurl.com/3k2a7u4b.

 » Outlook for Windows (a.k.a. New Outlook): The version that comes with 
Windows. Starting in 2024, it replaced Windows’s previous default mail 
application, which was called Mail. Windows 11 calls this version New Outlook. 
It’s confusing because that makes it sound like it is a replacement for 
Outlook 365, and it’s not. It doesn’t have the depth of functionality — at least 
as of this writing — that would enable it to be a full-featured replacement. 
Microsoft has announced that eventually this version will replace Outlook 365, 
though, so we can expect new features to gradually be added over the next 
few years. This book doesn’t cover Outlook for Windows in much detail, but 
Chapter 14 is devoted to the basics of this free app.

 » Outlook for Mac (a.k.a. New Outlook): This is a similar version to Outlook 
for Windows, but it has fewer features than the Windows version.

 » Outlook.com: If you go to the Outlook.com website using your web browser, 
you’ll find this online-only version. It’s a lot like Outlook for Windows. You’ll 
learn about it in Chapter 15.

 » Outlook Mobile: If you have an Android or iOS (Apple) smartphone, you can 
install a version of Outlook for your device from the app store for your 
phone’s operating system. Chapter 16 covers its most popular features.

To start Outlook 365 in Windows, follow these steps:

1. Open the Start menu.

2. Type Outlook.

Search results appear. These results may contain both Outlook and Outlook 
(New). See Figure 1-1.

https://tinyurl.com/3k2a7u4b
http://Outlook.com
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3. In the search results that appear, choose Outlook.

This is actually Outlook 365, although its name simply appears as Outlook  
or Outlook Classic.

Do not choose Outlook (New). If that is your only option, you probably don’t 
have Office 365 installed on your computer. Head on over to Office.com to 
rectify that.

The first time Outlook 365 runs, you are prompted to enter your email address and 
password. Then you’ll be guided through a brief setup that prepares Outlook to be 
able to send and receive mail with that account. Work through that, following the 
prompts, and then come back here to continue with this chapter.

FIGURE 1-1: 
Make sure you 

start the 
correct version 

of Outlook.

http://Office.com
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Switching to the Simplified Ribbon
The figures you see in this book and the instructions you read assume you’re using 
Outlook 365 the way it comes directly from Microsoft — either out of a box or as 
a download — with all the standard options installed. If you don’t like the way the 
program looks (or how things are named) when you install Outlook, you can 
change many of the things you see. If you change too much, however, some 
instructions and examples I give you won’t make as much sense. I suggest leaving 
the interface alone until you’re comfortable using Outlook. Chapter  18 covers a 
variety of customization options.

You might need to adjust one important option before you go any further, though. 
All Microsoft Office apps have a Ribbon, which is like a super toolbar across the 
top of the screen; you use the Ribbon to execute commands.

The Ribbon has two different ways it can appear. The Simplified Ribbon is the 
default for new installs of Outlook and looks like Figure 1-2. The Classic Ribbon 
was the default in earlier versions of Outlook and looks like Figure  1-3. Yours 
might have some different buttons on it.

The main difference is that the Simplified Ribbon has fewer buttons on it, and the 
buttons aren’t clustered into groups. Don’t let the name Simplified fool you into 
thinking that all the Classic mode commands aren’t there, though. Most of them 
still are. They’re just tucked away. Many of the buttons in Simplified mode open 
menus containing more commands.

This book’s steps and figures show the Simplified Ribbon (Figure 1-2), so if your 
screen doesn’t look like that, follow these steps to switch over to Simplified mode:

1. Click the Ribbon Display Options arrow at the far right end of the Ribbon.

It looks like a down-pointing arrow. A menu opens (Figure 1-4).

2. Click Simplified Ribbon.

The Ribbon changes to Simplified mode.

FIGURE 1-2: 
The Simplified  

Ribbon.

FIGURE 1-3: 
The Classic  

Ribbon.
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Using Email: Basic Delivery Techniques
Email is Outlook’s most popular feature. I’ve run across people who didn’t know 
Outlook could do anything but exchange email messages. It’s a good thing that 
Outlook makes it so easy to read your email, although it’s too bad so many people 
stop there.

Reading email
When you start Outlook, you normally see the Mail module, which is a screen with 
four columns. The leftmost column is the navigation bar. It contains buttons for 
each of Outlook’s modules (sections), such as Mail, Calendar, People, and so on. 
You switch between modules by clicking one of those icons.

To its right is the Folder pane, which lets you switch between different locations, 
such as folders or data files. The third column contains your list of messages. The 
right column (called the Reading pane) contains the text of one of those messages. 
If the message is short enough, you may see its entire text in the Reading pane, as 
shown in Figure 1-5. If the message is longer, you’ll have to open it or scroll down 
in the Reading pane to see the whole thing.

FIGURE 1-4: 
Switch to the 

Simplified  
Ribbon.
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To see an entire message, follow these steps:

1. Click the Mail button in the navigation bar to make sure you are in the 
Mail module.

You don’t need this step if you can already see your messages.

2. Double-click the title of a message.

Now you can see the entire message on its own window.

3. Press Esc to close the message.

The message window closes. (Note that closing a message does not delete it.)

A quick way to skim the messages in your Inbox is to click a message and then 
press the ↑ or ↓ key. You can move through your message list as you read the text 
of your messages in the Reading pane.

You can move the Reading pane to the bottom of the window if you prefer it to be 
wider and shorter. To do that, choose View > Layout > Reading Pane > Bottom.

Answering email
Anytime you’re reading an email message in Outlook, buttons labeled Reply and 
Reply All appear somewhere near the top of the screen. That’s a hint.

FIGURE 1-5: 
A received 

message in 
the Inbox.
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To reply to a message you’re reading, follow these steps:

1. In the Mail module, select the message to which you want to reply.

2. Click the Reply button on the Home tab of the Ribbon.

3. Type your response.

4. Click the Send button.

If you’re reading a message sent to several people besides you, you have the option 
of sending a reply to everyone involved by clicking the Reply All button.

Some people get carried away with the Reply All button and live to regret it. If you 
get a message addressed to lots of other people and click the Reply All button to 
fire back a snide response, you could instantly offend dozens of clients, bosses, or 
other bigwigs. Use Reply All when you need it, but make sure you really know who 
will be getting your message before you click the Send button.

When you reply to a message, by default, Outlook includes the text of the message 
that was sent to you. Some people like to include original text in their replies, but 
some don’t. In Chapter 5, I show you how to change what Outlook automatically 
includes in replies.

Creating new email messages
The process of creating a new email message in Outlook is ridiculously simple. 
Even a child can do it. But if you can’t get a child to create a new email message 
for you, you can do it yourself.

Follow these steps:

1. To make sure you are in the Mail module, click Mail in the navigation bar.

Each of the modules has its own unique appearance, and you’ll quickly learn to 
recognize at a glance which module you’re working with at any point.

2. Click the New Email button on the Home tab of the Ribbon.

An Untitled Message window opens, containing a simple form you can fill out.

3. Fill out the message form.

Put the recipient’s address in the To box, type a subject in the Subject box, and type 
a message in the main message box. Figure 1-6 shows a completed example.

4. Click the Send button.

Your message is on its way!
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If you want to send a plain email message, these steps are all you have to do. If you 
prefer to send a fancier email, Outlook provides the bells and whistles — some of 
which are actually useful. For example, you might send a High Priority message to 
impress some big shots or send a Confidential message about a hush-hush topic. 
(Discover the mysteries of confidential email in Chapter 4.)

Sending a file
You can attach a file (or multiple files) to an outgoing email message. You can do 
this in many ways, which I discuss in detail in Chapter 5. But for a teaser to that, 
here’s one perfectly good method:

1. Start a new email message in Outlook.

You learn how to do this in the preceding section.

2. On the Message tab of the Ribbon, click Attach File.

A menu opens up with a bunch of recent data files on it. See Figure 1-7. 
If you see the file you want to attach, select it, and you’re done; skip to Step 5. 
(If you’re asked whether you want to Share Link or Attach as Copy, go with 
Attach as Copy.) If not, proceed to the next step.

3. Click Browse This PC.

The Insert File dialog box opens.

FIGURE 1-6: 
Composing a new 

email message.
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4. Locate and select the desired file and then click Insert.

5. Continue sending the message normally.

You can also send links to files on your OneDrive; I get into that in Chapter 5, as 
well as how to send files directly from their home application. (For example, you 
can send a Word file to someone right from within Word.) So stay tuned for that, 
or skip to Chapter 5.

Maintaining Your Calendar
Time management is a myth. You can’t get more than 24 hours in a day — no 
matter how well you manage your time. But you can get more done in a 24-hour 
day if you keep your calendar current. Outlook can help you with that.

Entering an appointment
If you’ve ever used an old-fashioned paper planner, the Outlook Calendar will look 
familiar to you. When you click the Calendar button in the navigation bar and then 

FIGURE 1-7: 
Attaching a file 
to an outgoing  

message.
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click the Day button on the Home tab, you see a grid in the middle of the screen 
with lines representing each segment of the day. See Figure 1-8.

You can adjust the time intervals from as little as five minutes to as much as an 
hour. To adjust the time intervals, right-click one of the times along the left edge 
and choose a different interval from the shortcut menu.

To enter an appointment at a certain time, follow these steps:

1. Click Calendar in the navigation bar to switch to the Calendar module 
if needed.

2. On the Home tab, click Day.

You can create new appointments in other views, too, but let’s stick to 
Day for now.

3. Click the Today button.

Today’s calendar appears if it did not already. A black line indicates the current 
time, as shown in Figure 1-8.

4. Click the line next to the time you want your appointment to begin.

A colored bar appears there, ready for your typing.

FIGURE 1-8: 
Track your busy 
schedule in the 

Outlook Calendar.


